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| 1 Quick Reference

Frequencies (MHz)

Call Sign | Connect User Access My Pri, Sec BBS
W1XSC W1XSC-1 | 145.750, 223.620, 433.570
W2XSC W2XSC-1 | 145.730, 223.560, 433.590
W3XSC W3XSC-1 | 144.310, 223.540, 433.450
W4XSC W4XSC-1 | 145.690, 223.600%, 433.550

*223.600 is primarily for BBS forwarding; O.K. for back-up user access, testing.
BBS Locations

Call Sign | Location

W1XSC San Jose

W2XSC Crystal Peak (South County)
W3XSC Palo Alto

W4XSC Frazier Peak (East of Milpitas)
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2 Introduction

21 Purpose
This handbook is not an official Santa Clara County RACES deliverable.

This handbook provides the field packet radio operator with a job aid for the
different tasks and activities that are needed to be successful in the field.

It builds on a reasonable working knowledge of:
1. Digital communications using amateur packet radio
2.  Amateur packet radio hardware, software, and configuration
3. SCC RACES packet procedures, protocols, and standards

The experienced packet radio operator can use this handbook as a job aid and
real-time reminder of the tasks that need to occur when deployed to the field.
It is intended to ensure task consistency, completeness, and operational
alignment with SCCo RACES policies and procedures when carrying out field
packet radio operations.

2.2 How to use this Handbook

This handbook is not a tutorial on Amateur Radio Packet and will not teach you
all about packet, the hardware, software, and local procedures. You are
encouraged to attend SCCo RACES packet classes, acquire and use a packet
station, and participate in weekly and monthly packet practice, and regular
exercises where packet radio is deployed.

This handbook does provide a summary of how to operate packet radio in the
field. However, the packet operator is responsible for keeping current with
environmental, procedural, and SCCo RACES packet system changes by:

1. periodically checking the www.scc-ares-races.org website joining,

2. monitoring the packet@scc-ares-races.groups.io mailing list, and

3. attending SCCo RACES packet training courses

Updates to this handbook should be made by the handbook user as soon as
you become aware of them.

2.3 Other References

Have these SCCo RACES documents available to reference:
1. Standard Outpost Configuration Instructions - 08/04/2018
2. Standard TNC Parameter Settings — 10/31/2022
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3 Manual Packet Operations

3.1 TNC Commands

1. HELP [command]
When entered alone, lists all available commands. With a command,
provides details on that specific command.
2. MYCALL xxxxxx
Tells the TNC what its call sign is. Can be an FCC or Tactical Call sign
3. CONNECT calll [ via call2, call3, ... ]
Calll = Call sign of the station to be connected to. Adding “via call2...”
connects to the BBS by digipeaters.
4. CONVERS
Puts the TNC into Conversational mode. Then, whatever you type is
immediately transmitted.
5. <Cntl>C

Puts the TNC into Command Mode. Enter TNC commands at the prompt.

6. RESTORE DEFAULT

Resets the TNC to the factory default settings; performs the AUTOBAUD

routine. Defaults INTface to NEWUSER.

Hard reset can also be performed with internal jumpers.
7. INTFACE [ TERM | ...]

When set to TERMinal, the full command set of the TNC is available.
8. XMITLVL [ <value> ]

If blank, displays the current transmit level. If a value is included, sets the

transmit level.
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3.2 BBS Commands

1.

HELP or ? [ command ]
H = List of available commands. ? is the same as H or HELP
H <cmd> = Provides details on the command.
example: H List = shows all List command options and what they do.

LIST

L = Displays the headers for all unread messages, if any.

LA = Lists ALL messages, both read and unread

LM = Lists MY messages addressed to me

L> addr = Lists all messages that have “addr” in the message’s To: field

. READ #

# = The message number to be displayed.
KILL #
# = The message number to be deleted.
AREA
A = Lists all available bulletin areas.
AF = Gives a full listing of areas with descriptions (if available).
A area_name = Positions you to that area. Then, use the List and Read
commands to view messages.
SEND [ option ] <dest_address>
S[P] = Send Private; example: SP wéxrl4@w5xsc.ampr.org
SB = Send Bulletin; example: SB mtv@xsc
ST = Send Traffic; this is used for NTS packet messages
SC = Send Copy; to multiple destination addresses
example: SC wéxrld@w5xsc.ampr.org (enter the 15t address)
(BBS then prompts with Cc: for the other addresses. Enter
other addresses each separated by a comma.)
BYE
Disconnects from the BBS
XM [ lines to display ]
XM = Displays the current page length setting
XM 24 = Sets the page length to 24 lines
XM 0 = Turns off pagination (required when using Outpost)
NOTE: If a page length is set, message listings, messages and other
content longer than the page length are paused and a “More (N=no)?”
prompt is shown. Press SPACE to see the next page or ‘n’ to stop
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3.3 Connecting to the TNC with PuTTY

Set up PUTTY as follows:

1. Getting Started

| Find and run PuTTY

2. Session category

Connection Type: Serial

Enter serial port name (i.e.: COM3)

3. Session > Logging category

”

Session Logging: “All session output

Log file name: Enter a path and file
name

What to do if...: “Always append to
the end of it”

4. Terminal > Keyboard category

| Backspace key: “Control-H”

5.Connection > Serial category

Speed (baud): 9600

Data Bits: 8
Stop Bits: 1
Parity: None

Flow Control RTS/CTS

% PuTTY Configuration

Category:
Logging
—- Terminal
{ Keyboard
Bell
Features
—-Window
! Appearance
Behaviour
Translation
Selection
Colours
—J-Connection
Data
Proxy
Telnet
Rlogin
+-SSH
" Serial

About Help

1

Basic
Specify the destin:
slosi oo ()

Connection typei
ORaw OH

Load. save or del]

Saved Sessionsi

[
]
3
¢
j
Close window oni.
O Aways q
<
{

6. Window > Translation category

Change “Remove character set” to
Win1252 (Western)

7. Session category

Saved Sessions: Enter a name in the
field, click Save

Click Open to start the session

8. Verify

Put cursor in the PUTTY text area.

Make sure the TNC is turned on.

Press Enter and confirm you see the
TNC Prompt (cmd:)
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3.4 Start of Shift: Configure TNC Settings
HINT!!! Create TNC Init Command text files

Create text files that contain the Start-of-Shift and End-of-Shift TNC commands

for the TNCs you might use. This should be done before you ever find yourself

needing to send and receive packet messages manually.

1. For each TNC that you use, create a text file with the “Start of Shift” and
“End of Shift” TNC commands.

2. Each file should contain both sets of commands.

CAUTION: Do NOT cut-and-paste directly from the PDF into your terminal
emulator; it may not work.

**Best practice: copy the commands first into a text editor (Notepad),
save it, and then copy-and-paste from

. : Kantronics KPC3-Plustxt - Notepad
there into your terminal program. 8 Kantrorics s

. ) File Edit Format View Help
3. Save each file with the TNC Name. |--- KPC3-Plus Start of Shift --

INTFACE TERMINAL

> Packet > Field Responder > TNC Init Files CD SOFTWARE
Name - Date modified Type NEWMODE: ‘O
8BITCONV ON
& | Kantronics_KPC3.txt 10/3/ Text Docul BEACON EVERY ©
& Kantronics_KPC3-Plustxt ~ 10/3/2021 8:57 AM  Text Doc SLOTTIME 10
5 Kenwood_TH-D72A.txt 10/3/2021 8:53 AM  Text Docy PERSIST 63
& | Kenwood_TM-D710A.txt 10/3/2021 8:;51 AM  Text Docu PACLEN 128
&) MFJ_1270C-1274C.txt 10/3/2021 9:00 AM  Text Docu IPRERANE 2
) FRACK 6
& | TAPR_TNC2.txt 10/3/2021 9:02 AM  Text Docu RETRY 8
— —a WCHECK 30
TNC Reset

Insure all TNC settings are at the current SCCo standard values

1. Get current Transmit Level
Connect to the TNC with PuTTY
cmd: XMITLVL (for KPC-3+)
Record the value displayed.

2. Reset the TNC
cmd: restore default

Watch for...
PRESS (*) TO SET BAUD RATE

When you see this text, PRESS “*” and

enter your call sign at the prompt. ;
. cmd:xmitlvl 261
ENTER YOUR CALL SIGN:<callsign>[.itivi was 100

cmd: INT Term cmd:
cmd: XMITLVL <value>
cmd: CD software

cmd:restore default
XXXXXXXOXXXXXXXXBXXXXXXXXXXXXXXXX@2FF Ffpf "
PRESS (*) TO SET BAUD RATEL
XXXXXXXBXXXXXXXXGXXXXXXXXXXXXXXXXp2Ff FFpf "
PRESS (*) TO SET BAUD RATE

ENTER YOUR CALLSIGN=> wéxrl4

KANTRONICS KPC3P VERSION 9.1

(C) COPYRIGHT 2002-2005 BY KANTRONICS INC. |
DUPLICATION PROHIBITED WITHOUT PERMISSION OF
cmd:int term

INTFACE was NEWUSER
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3. Start of Shift
If assigned a tactical call sign, then check or enter it now:
cmd: mycall <TacCall>
4. Send Start-of-Shift TNC commands
Select and copy (<ent1>C) the entire “Start of Shift” command list
from the text file.

At Putty, mouse right-click to paste the TNC commands

3.5 End of Shift: Restore TNC Settings

When your shift is over and before you pack up the gear or turn it over to

someone else, return the TNC to “normal” settings.
AN e o\ s AT 2
1. End of Shift TNC cleanup e kPC3-PliiS ERd 6F SHIFE -
___ Disconnect from the BBS.
____ Cut-and-paste the “End of Shift” TNC STREBEN FiC

commands into PuTTY at the TNC

< >

command prompt

3.6 Getting ready for Manual Messaging

Directory structure for manual messages
1. Create a directory structure (your choice) for your manual text message

files, such as:

e C:\MyMessages\XND-24-1009T  (Activation no, example below)
e C:\MyMessages\2024-10-09 (date)

e C:\MyMessages\XND-F14 (assignment)

e  Other

2. ldentify a starting message number.

< ~ © @ > ThisPC > OS(C) > MyMessages/

.

® New ¥ O @D W N sor == f
Drivers Logs ‘-.

| MyMessages Misc p
- XND-24-1009T

X

Misc g

4

XND-24-1009T

- T RSy DI Y SR
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3.7 Manual message basics

Knowing how manual packet works will help you troubleshoot problems.
Manually create a message without Outpost or PackltForm for test purposes.

1. Manually create a packet message
Open Notepad or any other text editor.
Create a message with the four key elements of a manual packet

message:

sp <destination>
<subject line>
<message lines>
/ex <CR>

Send Private

standard SCCo Subject line format

the essence of the message to send
End of Message

Create a round-trip test message (send to yourself) with whatever

message content you want (example below).

sp <dest address>—~

—

<subject line>

<message line 1>
<message line 2>

<message line n>

/ex

Use the Subject as the file name and save to your manual data folder.

8 *XND_1021M R Weather H.. — m] X

File Edit Format View Help

Sp XNDQ14@W1XSC

XND_1021M_R_Weather Heads up

To: Xanadu Station 14

From: County Fire

Please double-check the status of all
equipment and confirm its deployment
readiness.

weather forecast calls for high winds
and lightening tonight through
Sunday .

An official request for this
information will follow.
/ex

| 1

2. Use PuTTY to the manually send the packet message

Highlight the entire message from the saved file.

Select All with <ctrl>A, then Copy using <Ctrl>C.

Start PuTTY.
Connect to the BBS.

Put the cursor in the PUTTY screen by the BBS Prompt.

Paste using Mouse right-click into Putty.
The message should start transmitting immediately.
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3.8 Sending a manual PackltForm message

3.8.1 Run manual PackltForms

1. Open File Explorer, navigate to
C:\PackltForms\Outpost\SCCo

2. Find and double-click on
manual.cmd.

3.8.2  Setup Manual PackitForm
SETUP Page is displayed.
3. Fillin or update all fields:

e User information

e Tactical call information

e  Select your Archive Folder
(messages are auto saved
here)

e Select Terminal Encoding
e Next Message Number

4. Press OK when done.

3.8.3 Pick and fill in a Form
HOME Page is displayed.

5. From the dropdown menu,
select a PackltForm.

Press Create Message.
Fill in the PackltForm as usual.

When done,
press Create Message.

3.8.4 Create the packet message
MESSAGE Page is displayed.

9. If needed, check the boxes if

this message is Urgent (D or a
Bulletin .

10. In the To: Field:
e enter a single Dest address
e multiple addresses
separated with commas.
11. When done, press Log and
Send.

Eile Edit View History Bookmarks Tools Help 1
(5 | Setup PackitForms X |+

C @ O D 127.00.1:54

= .

Santa Clara County ARES/RACES Packit

User Call Sign: wexrL4

User Name: Herman Munster

P NP |

Message ID Prefix: RL4 (3 characters max)

Use Tactical Call Sign

Tactical Call Sign: xnpDe14
Tactical Name:

Message ID Prefix:

Fire Station 14
X14 (3 characters max)
Archive Folder: C:\MyMessages\XND-24-1009T
Terminal Encoding: Windows-1252 v (2

A B A e A e el it A o A A e AN A s M

Next Message Number.
L% N -
L SCCo PackitForms x +
7 C @ O D 127001

Santa Clara County ARES/RACES PackltForms
Edit 1CS-309 Log

Create a message to send
Message type: | v

RN - R

Create Message

Nmime

A st o - IS ey o

File Edit View History Bookmarks Jools Help
1

1
<@ SCCo PackitForms X | X14-312M_R_ICS213_Eqd

{
€« > Cc @ O D 12001 4
1
|

Urgent: Bulletin: []
To: XNDEOC@wlxsc.ampr.org

Subject: x14-312M_R_ICS213_Equipment Status

Message: !SCCoPIFO!
#T7: form-ics213.html

#V: 3.11-2.2

i
MsgNo: [X14-312M] 4
la.: [10/09/2023] 4
1b.: [20:16] ?
5.: [ROUTINE] 3
Log and Send (’

{
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BBS COMMAND Page is displayed.

12. Copy the message. Put your
mouse cursor in the text area,
and then either: Edit > Select
All, then Edit > Copy or
enter<ctrl>A <ctrl>C.

NOTE: Do not change the subject line.

3.8.5 Send the message with PuTTY
PuUTTY is displayed.

13. Make sure you previously
copied the packet message
from the BBS Command Page
(previous section).

NOTE: Include the blank line below
the /EX statement.

14. Start PuTTY
15. Connect to the BBS

Verify you get the BBS Prompt.
16. Paste the message in PuTTY:

e Put the cursor in the PuTTY
text area after the last BBS
prompt, and then

e Mouse right-click to paste
in the message.

Reminder: All SCCo BBSs have a 2-minute
inactivity timer.

File Edit View History Bookmarks Tools Help ]
e SCCo PackitForms X | 127.00.1:64874/teX
< C @ O D 127.00.1:64874/text-24

SP XNDEOC@w1XSC.ampr.org
X14-312M_R_ICS213_Equipment Status
ISCCoPIFO!

#T: form-ics213.html

#V: 3.11-2.2

MsgNo: [X14-312M]

la.: [10/09/2023]

1b.: [20:16]

5.: [ROUTINE]

7.: [Logistics]

8.: [station caption]

9a.: [Xanadu EOC]

9b.: [Xanadu Fire Station 14]
10.: [Equipment Status]

12.: [All equipment is ready for deployment.]
Rec-Sent: [sender]

opCall: [W6XRL4]

OpName: [Herman Munster]
Method: [Other]

other: [Packet]

opDate: [10/09/2023]

OpTime: [20:17]

1 /ADDON!

At Ak A i maedstentinth A0 A A B st et et A B

/EX
PPN T PP P J

ISP XNDEOC@wlxsc.ampr.org p
1X14-312M_R_ICS213_Equipment Stg
'IsccoPIFO!

\#T: form-ics213.html

(#v: 3.11-2.2

IMsgNo: [X14-312M]

lla.: [10/09/2023]

"1b.: [20:16]

15.: [ROUTINE]

17.: [Logistics]

18.: [Station Captain]

19a.: [Xanadu EOC]

'9b.: [xanadu Fire Station 14]
110.: [Equipment status]

112.: [A11 equipment is ready f
IRec-Sent: [sender]

lopcall: [W6XRL4]

'OpName: [Herman Munster]
\Method: [Other]

jO0ther: [Packet]

IopDate: [10/09/2023]

lopTime: [20:17]

PAEITPIRY Sy T WP UOWmgRee S - WORRTGRegepupe VY TSR SR TS TR prevgapp

: | /ADDON!
VEX o ____}
To: XNDEOC@wlxsc.ampr.org ;
Subject: 3
Enter message. End with /EX oe
column (AA aborts) $
Msg Queued 4
(#1) > i
{
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38 6 Sending PIain Text Messages File Edit View History Bookmarks Tools Help

with PuTTY

1
{
e G Google X XSC ICS-213 Message X 3
PackltForms does support manual Plain 4
Text message sending and receiving. C @ O D 12700156660 mang
1
e fromthe Home Page, dropdown Urgent: ) Bulletin: (] !
menu, pick Plain Text Message. - {
To: “a comma-separated list 3
The Message Page opens. 4

Subject: X16-1251M_R_Equi t Stat
e Message ID and Handling order : == preT T i
are filled in, DO NOT CHANGE THIS! 1
Message: i
e Fillin... {
- To: destination packet address j
- The rest of the Subject text {
- Your plain text message 3

. Log and Send

e Finally, press Log and Send 3
3
The rest of the send process is the same. }3
e Sy s SN I e
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3.9 Receiving a PackltForm message manually

3.9.1

Receive a PackltForm message

PuTTY is displayed.

1.

3.9.2

Connect to the BBS using
PuTTY.

List your messages with LM
Read your messages with R #

Highlight all text from Date:
to I/ADDON! (inclusive).

Copy Text from PuTTY: just
select the text to copy it to
the clipboard.

Recover the Message

HOME Page is selected.

5.

Put your cursor in the lower
“View a received message”
section, and enter

Edit > Paste or <ctrl>V to
paste in the message.

Press Log and View.

e This entry is logged to the

ICS 309

e The received message is

opened in its PackltForm.

Once the PackltForm is
opened, print it and hand it
off for delivery.

S
lother:

IDate Mon, 9 Oct 2023 20:26:51 PS
|From: xndxl4@wlxsc.ampr.org
ITo: xndeoc@wlxsc

:Subject: X14-312M_R_ICS213_Equipmd

1

1 ISCCoPIFO!

1#T: form-ics213.html
I#v: 3.11-2.2

| FVPRPORIRIN o Pr e S PO S URg v Ser veu

P GG S Ry g
[Packet] i
[10/09/2023] {
[20:17] i

loppate:
OpTime:
;| /ADDON!

At gy s g —.V-v—m‘
View a received message

Enter the received message, including the From, Subject‘
drag and drop or upload a file.

Message: ga : [xanadu EOC]

Upload

Download

Received Date: 10/09/2023 Time: 20:41

Reset Fields

LA 0 A 00 b i s s e o,

Log and View

13/16



3.10 Notes on Outpost Tags

*  Messages sent from Outpost occasionally have “tags” inserted in
messages that you might see.

¢ Some of the more common tags are:
— IRRR! Request Read Receipt
— IRDR! Request Delivery Receipt
— ISCCoPIFQ! This is a PackltForm message
— 1/ADDON! The end of a PackltForm or other Addon message
— 1UG! Mark message as urgent (lists as RED in the Outpost listing)

e PackltForms will ignore many Outpost tags that it sees and they will
not show up in the message.

3.11 Viewing saved messages

View your saved messages in the directory set up in Section 3.6. For
example: C:\MyMessage\X14-24-1009T\

Sort by clicking on the Name or Date Modified column headers.

B - | X14-23-1009T

Home Share View 1
v 4 > ThisPC > Windows (C:) > MyMessages > X14-24-1009T v O ) Sea'c‘ng
MyActivations ~  Name Date modified ;
1

MyAddons ] EOC-1245P_R_Report Station_Staff Status.txt 10/14/2024 16:07 AM
MyMessages ;} X14-310M_R_Check-In XND014, Fire Station 14.txt 10/14/2024 16:12 AM !
Logs | X14-312M_R_ICS213_Equipment Status.txt 10/14/2024 17:20 AM !
Misc | X14-317M_R_ICS213_72 hour staffing plan.txt 10/14/2024 18:15 AM 1
X14-23-1009T | X14-319M_R_EOC213RR_Xanadu Complex Fire.xt  10/14/2024 18:02 AM |
MyMsgs2 ] X14-321M_R_Surprise Pizza.txt 10/14/2024 18:23 PM ’
MyMsass ] X14-325M_R_Check-Out XNDO014, Fire Station 14.txt 10/14/2024 18:12 PM :‘

sgs.
e et B Sttt g I et BBl b cemenieatstnd)
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3.12 Notes on Manual ICS 309 Comm Log

1. From the PackltForm Home Page, clicking on Edit ICS 309 Log opens the
ICS 309 form for editing and printing.
2. Allfields are editable.
3. Required fields are highlighted in RED.
4. Trash Can symbol deletes the entry.
5.  Plus symbol adds another line for a manual entry.
6. Erase All —clears the form.
Once pressed, Undo Erase All is displayed that will restore the form
7. Generate CSV File — creates a .csv file of the Comm Log.
8. Print — prints the Comm Log to the selected printer.
9. Save —Saves any changes you made.
Eile Edit View History Bookmarks Tools Help — o X
@ SCCo PackitForms X 1CS-309 X =t e
C @ QO DO 127.0.0.1:50400/manua o% ¥ mw H & =
COMM LOg 1. Incident Name and Activation Number 2. Operational Period (Date/Time)
ICS 308-SCCo
ARES/RACES l m/d/yyyy m/d/yyyy
| From: {hh:mn To: {hh:mm
3. Radio Net Name (for NCOs) or Position/Tactical Call 4_Radic Operator (Name, Call Sign)
|| | | l. Icallfsign '
5. COMMUNICATIONS LOG
- FROM TO —
(24:00) Call Sign/ID Msg # Call Sign/D Msg #
13:49 XNDe22 X22-121M XNDEOC@WL ... R_Check-In XND@22, Kios .. i @
14:27  [xnNDe22 X22-123M  |XNDEOC@W1 .. R_ICS213_Opening Status |m | @
14:41 xndeoc@wl .. XND-3001P |XND©22 X22-124M R_ICS213_opening status .. i @
i
15:13 xndeoc@wl .. XND-2009P |XND@22 X22-126M R_ICS213_4-hour festiva .| M @
15:33 XND@e22 X22-127M XNDEOC@wW1 ... I_EOC213RR_XANADU PICNI . i @
™ e T T — —
O 2o v e R L S L A ANDEUCEN I oy s SO P o s s v s e
—L
09:26 XNDO14 X14-313M XNDEOCEWL ... R_Check-out XNDe14, Fir ,E @
09:37 xndeoc EOC-1245P |XND@xsc R_Report station/staff .Ii @
hh: mm 6
6. Prepared By (Name, Call Sign) BA. Signature 7. Date & Time Prepared
| ' |m/d/yyyy llhh:mm I
fps 32?‘3000 ARES/RACES (Rev. 2021- |Erase All| [Generate cSV File]| [Print]| [Save|
:
PIF: 1.1
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